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 INTRODUCTION 

 Product Overview 

Intellix™ BMT 330 (the product) is a monitoring system that continuously: 

▪ measures the condition of transformer bushings (through changes in Capacitance 
and Power Factor) for one or two sets of three bushings in a single three-phase 
transformer, or three single-phase transformers. 

▪ detects any Partial Discharges (PD) activity in the transformer main tank (measured 
as high frequency pulses). 

All measurements and alarms can be reported to a remote monitoring centre via the 
standard RS-485 connection or one of the other available communications options. 
Alternatively, they can be manually downloaded locally using the USB cable. The product 
is supplied with PC configuration software that is used to set up the product. Refer to the 
Intellix™ BMT 330 User Manual. 

The following sensors can be fitted: 

▪ Three Bushing Adaptors (Primary input) connected to the tapping point of the 
bushings being monitored. 

▪ (Optional) Three Bushing Adaptors (Secondary input) connected to the tapping 
point of a second set of bushings being monitored. 

▪ Three Current Transformer (CT) sensors at the transformer(s) neutral (if available). 

▪ Three magnetically-mounted temperature sensors (MMTS) mounted on the 
transformer tank(s) to measure the transformer top oil temperature. 

▪ A combined ambient temperature and humidity sensor mounted at the bottom of 
the product cabinet. 

 Scope 

This manual details the installation tasks for the product. 

 Abbreviations & Definitions 

Table 1-1: Installation materials 

Abbreviation Meaning 

BMT Bushing Monitor for Transformers 

HFCT High Frequency Current Transformer 

HV High Voltage 

LOTO Lock Out, Tag Out procedure 

LV Low Voltage 

PD Partial Discharge 
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 SAFETY 

 Symbols 

The meaning of symbols used on the Intellix™ BMT 330: 

 

Caution. Refer to the Installation Manual / User Manual to prevent death, 
bodily injury, equipment damage or loss of data. 

 

Electrical Hazard. Risk of electric shock. 

 

Primary Protective Earth connection. 

The meaning of safety symbols used in this manual: 

 

Caution: A procedure, practice, or condition could cause death, bodily injury, 
equipment damage or loss of data. 

 

Electrical Hazard: Risk of electric shock. 

 

Laser radiation: LED transmitters for fibre optics are classified as IEC 
60825-1 Accessible Emission Limit (AEL) Class 1. Class 1 devices are eye-
safe to the unaided eye. Do not view directly with optical instruments. 

 Installer Safety 

 

WARNING: All procedures in this manual must be followed. Any deviation 
could cause irreversible damage to the transformer being monitored and/or 
the Intellix™ BMT 330, and could lead to property damage, personal injury 
and/or death. 

 

WARNING: Before installing the Intellix™ BMT 330, third parties must have 
received appropriate training for working at height. This includes, but is not 
limited to, ‘Working at height’ and ‘Using Mobile Elevated Working 
Platforms’. 
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 TECHNICAL SPECIFICATIONS 

 Measurements 

Table 3-1: Measurements 

Feature Value 

Input current measuring range 2 mA – 200 mA rms, 1% of reading 

Relative phase angle accuracy 0.01 deg of angle 

Maximum number of PD measured 200 pulses per cycle (50 to 60 Hz) 

Measurement category for signal inputs CAT III. 5 V AC rms, 200 mA; on each phase 

Maximum bushing temperature at Bushing 
Adaptor 

90 °C (194 °F) 

 Environmental 

Table 3-2: Environmental 

Feature Value 

Cabinet operating temperature range −40 °C to +55° C (−22 °F to +131° F) 

When equipped with multi-master comms 
option 

−20 °C to +55 °C (−4 °F to +131 °F) 

Operating humidity range 5 to 95% RH, non-condensing 

Maximum operating altitude 2000 m (6500 ft) above sea level 

Storage temperature range −40 °C to +85° C (−40 °F to +185 °F) 

Minimum ambient temperature for 
installation and service activities 

−20 °C (−4 °F) 

Cabinet protection level IP55 

Bushing Adaptor protection level IP66 

Intellix™ BMT 330 weight 20 kg (44 lb) 

Bushing Adaptor weight 350 gm (0.8 lb), typical 

Bushing Adaptor operating temperature −40 °C to +90 °C (−40 °F to +194 °F) at 
Bushing Tapping Point 

 Power 

Table 3-3: Power 

Feature Value 

AC Power supply requirement 100 to 240 V AC, 50 to 60 Hz, 1.24 to 0.41 A 

Output relays (quantity 3) Single Phase Change Over (SPCO),  

Maximum Rating (resistive load): 

2 A @ 240 V AC, 2 A @ 30 V DC 

Fuse (one each on Live and Neutral) 10 × 38 mm time delay 500 V, 3 A 
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 Type Tests 

Table 3-4: Type Tests 

Category Standard Class/Level Test 

EMC 
Emissions 

CISPR 11 A Radiated & Conducted 
Emissions 

FCC part 15 A Radiated & Conducted 
Emissions 

IEC 61000-3-2 A Harmonic Current Emissions 
Limits 

EMC Immunity IEC 61000-4-2 IV Electrostatic Discharge 

IEC 61000-4-3 III Electro Magnetic Field 
Immunity 

IEC 61000-4-4 III Electrical Fast Transients 

IEC 61000-4-5 III Surge Immunity 

IEC 61000-4-6 III Conducted RF Immunity 

IEC 61000-4-8 IV & V Magnetic Field Immunity 

IEC 61000-4-11 III Voltage Dips & Interruptions 

IEC 61000-4-12 X 2.5 kV & 1 kV Oscillatory Wave 

IEC 61000-3-3 Pst 10 min, Plt 120 min Voltage fluctuations & flicker 

IEC 60255-5 5 kV, 2 kV & 500 V DC Impulse, Dielectric & 
Insulation resistance testing 

Environmental IEC 60068-2-1 −40 °C Cold 

IEC 60068-2-2 55 °C Dry Heat 

Environmental IEC 60068-2-6 10-500Hz, 1g operation 

10-500Hz, 1g endurance 

Vibration 

IEC 60068-2-30 55 °C, 95% RH Damp Heat 

EN 60529 Cabinet – IP55, 
Adaptor – IP66 

Degree of Protection 

Safety IEC 61010-1  2010 + Corr1 

EN 61010-1  2010 

UL 61010-1  3rd Edition 
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 PRE-INSTALLATION 

 Location 

The Intellix™ BMT 330 requires an installation location with: 

▪ an electrical supply of 230 V AC (1 A) or 110 V AC (2 A). The electrical supply must 
have an independent means of disconnection and be clearly identified with a label. 

▪ a suitable site access to carry the product to its destination 

Note: The dry weight of the product is approximately 20 kg. 

▪ a base that can take the 30 kg distributed load and accommodate the product 
dimensions of 

600 mm long × 400 mm wide × 200 mm deep. 

There should be at least 750 mm clear space in front to allow access to the product. 

In addition, the chosen location must: 

▪ not interfere with the transformer cooling system, regular maintenance activities or 
operation of the electrical supply disconnection device. 

▪ be within the maximum line length of the chosen communications method. 

It is recommended that the Intellix™ BMT 330 be: 

▪ installed sufficiently close to the transformer(s) so that the cable runs from the 
product to the bushings are likely to be less than 25 m. 

▪ mounted on the transport stand (see Appendix A for dimensioned drawings). 

 Requirements 

Observe the following requirements to install the product: 

▪ The transformer is to be de-energised, switched off and earthed for the duration of 
the installation process. 

▪ Cable runs are required from the product location to the bushings. 

▪ To facilitate Bushing Adaptor installation and test, the customer is responsible for 
supplying a safe and suitable working environment. 

 

It is not recommended that the product be mounted directly on the 
transformer. If this method of installation is being considered, contact GE 
Technical Support. 

 

All coaxial cables from the Bushing Adaptors to the product must be run 
inside a protective electrically grounded metal conduit. 

 

WARNING: If the equipment is installed or used in a manner not specified 
by the manufacturer, the protection provided by the equipment may be 
impaired 

 

If working at heights is required during the product installation, it is the 
responsibility of the installer as a minimum to: 
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 Base & Access 

The base should be level and sufficiently firm to allow the stand to be bolted down. See 
Appendix A for the required dimensions. Consider the following factors: 

▪ The site should be readily accessible as the product weighs approximately 20 kg 
(44 lb). 

▪ There should be 2 m (79 in.) headroom. 

▪ If a new concrete pad is required, the dimensions should be at least 

610 mm (24 in.) long × 1220 mm (48 in.) wide × 90 mm (3 ½ in.) deep, 

with an #3 (10 mm) steel reinforcing bar around the perimeter. This should be 
grounded and bonded in accordance with local practice and code. 

▪ The product should never be mounted directly to the transformer without first 
consulting GE Technical Support. 

▪ The intended AC supply is to be provided with a switch or circuit breaker so that it 
can be independently de-energised. The location of the switch or circuit breaker 
should be near the intended location of the product and within easy reach of the 
operator. 

If the GE manufactured mounting stand has not been purchased, a stand should be 
constructed as outlined in Appendix A. 

 Communications & Power Cable Runs 

If possible, communications and power cable runs from the intended product location to 
their sources should be pre-installed. See Figure 5-1 for the general installation layout. 

 Bushing Adaptor Cable Runs 

If possible, Bushing Adaptor cable runs from the intended product location to the 
transformer bushings should be pre-installed. See Figure 5-1 for the general installation 
layout. 

▪ Ensure that planned work complies with national and site regulatory 
requirements. 

▪ Ensure that any third-party equipment to be used is suitable and safe 
before commencing work. 

▪ Ensure that third parties have received appropriate training for 
working at height. This includes, but is not limited to, ‘Working at 
height’ and ‘Using Mobile Elevated Working Platforms’. 

 

All coaxial cables from the Bushing Adaptors to the product cabinet must 
be run inside a protective electrically grounded metal conduit. 

 

All installation activity should take place in ambient temperatures greater 
than −20 °C (−4 °F) to prevent damage to connectors and cabling because 
they may become brittle at extreme low temperatures. 
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Details of recommended conduit and fittings are listed in Appendix B. 

All Bushing Adaptors and HFCT cables are run into the product cabinet. Each of these 
coaxial cables must be properly identified using cable markers provided with the 
installation kit (see Appendix B) as follows: 

▪ Cable for Primary input from phase A Bushing Adaptor: P1 

▪ Cable for Primary input from phase B Bushing Adaptor: P2 

▪ Cable for Primary input from phase C Bushing Adaptor: P3 

▪ Cable for Primary input from spare single phase Bushing Adaptor (if available): P4 

▪ Cable for Secondary input (if available) from phase A Bushing Adaptor: S1 

▪ Cable for Secondary input (if available) from phase B Bushing Adaptor: S2 

▪ Cable for Secondary input (if available) from phase C Bushing Adaptor: S3 

▪ Cable for Secondary input (if available) from spare single phase Bushing Adaptor (if 
available): S4 

▪ Cable from HFCT (single tank or single phase A, if available): N1 

▪ Cable from single phase B (if available): N2 

▪ Cable from single phase C (if available): N3 

▪ Cable from spare single phase (if available): N4 

The above coaxial cables are connected to the corresponding terminals of the grounding 
switch inside the product cabinet, such that the central wire is routed to the core side 
and the braid shield wire is routed to the shield side. See Appendix C. 

 

If working at heights is required during the product installation, it is the 
responsibility of the installer as a minimum to: 

▪ ensure that planned work complies with national and site regulatory 
requirements. 

▪ ensure that any third-party equipment to be used is suitable and safe 
before commencing work. 

▪ ensure that third parties have received appropriate training for 
working at height. This includes, but is not limited to, ‘Working at 
height’ and ‘Using Mobile Elevated Working Platforms’. 

 

When installing conduit to Bushing Adaptors, ensure that the conduit drops 
away from the Bushing Adaptor body. 
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 INSTALLATION 

Figure 5-1 illustrates the general installation layout of an Intellix™ BMT 330 with the 
required connections for a single transformer. 

 
Figure 5-1: General installation layout - single transformer 

Figure 5-2 illustrates the general installation layout of an Intellix™ BMT 330 with the 
required connections for a bank of three single phase transformers. 

 
Figure 5-2: General installation layout - Bank of 3 single phase transformers 

 

The product is supplied with factory default settings for all parameters, e.g. 
alarm thresholds. For optimal performance, specific settings are required 
for each installation. 
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Figure 5-3 shows the rear side of the product door. 

 
Figure 5-3: Rear side of the product door 

Figure 5-4 shows the key parts inside the product cabinet. 

 
Figure 5-4: Inside the product cabinet 

LED control board 

Mains input 

CANbus and 
RS-485 

Power supply 

Relay 
connectors 

AC 
protection 
shield 

System PCBs 

Bushing & Neutral 
CT inputs 
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communications 
module 

Grounding 
bars 

USB cable 
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 Mounting 

 

WARNING: Do not attempt to install the product unless the transformer is 
de-energised and switched off. 

 

WARNING: Ensure that the HV and LV bushings are grounded before 
installation of the product. 

 

WARNING: Once installed, the product may have more than one source of 
supply. Disconnect all supplies at their source before accessing the cabinet 
for servicing. Follow LOTO procedures. 

 

The product should not be mounted where it may interfere with the 
transformer cooling system or maintenance activities. 

 

There should be at least 750 mm (30 in.) clearance in front of the product to 
allow access to the cabinet. 

 

Contact GE Technical Support before mounting the product directly on the 
transformer. 

The GE stand is shipped with the top portion of the stand inverted. Remove the 
hardware holding the stand together, then remove the top section which is inverted 
within the larger stand base, and assemble in an upright position reusing the original 
hardware. 

▪ Use the diagram of the mounting stand footprint (see Appendix A) or the mounting 
stand itself (recommended) to mark at least one hole in each mounting tab from the 
mounting stand. 

▪ Use adequate concrete anchors (not supplied) to anchor the mounting stand to the 
mounting surface. 

▪ Ensure that the stand is on a horizontal level surface. 

Note: Three mounting holes are available on each foot of the stand base, but only one 
hole is required for installation. 

 Bushing Adaptor Connections 

A list of parts and tools required for the product installation is given in Appendix B. 

Preparation of the coaxial cables is described in Appendix C. 

The Bushing Adaptor is supplied assembled, but with both O-rings separately packed. In 
overview the installation is composed of the following steps: 

▪ A pre-installation check is performed. 

▪ Conductive grease is applied to thread (threaded Bushing Adaptor only). 

▪ The whole Bushing Adaptor is screwed into the bushing tapping point. 

▪ The top cover of the Bushing Adaptor is removed leaving the body in place as 
illustrated in Figure 5-5. 
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▪ A Bushing Adaptor circuit integrity test is performed. 

▪ The cabling is attached through the top cover and O-ring. 

▪ The top cover of the Busing Adaptor is re-attached as illustrated in Figure 5-6. 

 
Figure 5-5: Bushing Adaptor - without top cover 

 
Figure 5-6: Bushing Adaptor - with top cover 

 

The rubber O-rings must not be contaminated with grease during the 
assembly process. 

 

Both ends of the coaxial cables for the Bushing Adaptor and Neutral CT 
must be prepared and fitted with pin terminals as described in Appendix C. 

 

All coaxial cables from the Bushing Adaptors to the product cabinet must 
be run inside a protective electrically grounded metal conduit. See 
Appendix B.3 for recommended conduit and fittings. 

 

If working at heights is required during the product installation, it is the 
responsibility of the installer as a minimum to: 

▪ Ensure that planned work complies with national and site regulatory 
requirements. 

▪ Ensure that any third-party equipment to be used is suitable and safe 
before commencing work. 

▪ Ensure that third parties have received appropriate training for 
working at height. This includes, but is not limited to, ‘Working at 
height’ and ‘Using Mobile Elevated Working Platforms’. 



MA-017 – BMT 330 Installation Manual – Rev 3.3 4-Mar-22 Page 17 of 69 

 Bushing Adapter Caps 

The Bushing Adaptors are shipped with a plastic-threaded cap as shown in Figure 5-7. 

 
Figure 5-7: Bushing Adaptor with cap 

When removing the original test tap caps from the bushings, first check that they fit the 
plastic-threaded cap from the new bushing adapter. If it is a good fit, continue with the 
Bushing Adaptor installation. If the original test tap cap does not fit the plastic-threaded 
cap, halt the installation and contact GE Technical Support. 

 Install a Bushing Adaptor 

To install a Bushing Adaptor: 

 See Appendix D for the test procedure on how to verify the circuit integrity of the 
Bushing Adaptor. 

 Check Bushing ID reference against Bushing Adaptor ID reference. 

 Remove the bushing test tap covers. Retain the tap covers in a safe place because they 
will be required in the future when decommissioning the product. 

 With clean hands, put the smaller O-ring in its seat as shown in Figure 5-6. 

Note: There are two spare O-rings supplied in the shipping package of each Bushing 
Adaptor. Store these safely for future use should the Bushing Adaptor need to 
be re-installed. 

 Apply the conductive grease to the bushing adaptor threads. The high temperature anti-
seize carbon conductive grease (supplied with the installation kit) must reach all 
threads. To start, apply an even amount of grease to the first few threads as shown in 
Figure 5-8. 

 

WARNING: After connecting the Bushing Adaptor, it is crucial that the 
Bushing Adaptor circuit integrity tests in Appendix D are performed. 
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Figure 5-8: Bushing Adaptor with initial threads covered in grease 

As the bushing adaptor is installed into the tapping point of the bushing, the grease will 
work its way down ensuring an even coating across all threads as shown in Figure 5-9. 

 
Figure 5-9: Bushing Adaptor with all threads covered in grease 

 Screw the complete Bushing Adaptor into the tapping point of the bushing. First just 
hand-tighten and check that the resistance between the Bushing Adaptor body and the 
bushing body is less than 5 Ω. 

Note: If required, scrape a little paint off the bushing well to get a good conductive 
path, or alternatively, find another suitable grounded point so that ground 
continuity can be tested between the ground and the Bushing Adaptor body. 

 Tighten the Bushing Adaptor to the required torque defined in the installation drawing 
(46-XXXX) provided with each Bushing Adaptor. It is important to tighten the Bushing 
Adaptor in steps of 20 N m (15 lb ft) until you reach the final torque requirement to 
minimise mechanical stress. 

Note: A suitable torque wrench is specified in Table B-3: Customer-supplied items. 

 Finally, re-check that the resistance between the Bushing Adaptor body and the bushing 
well is still less than 5 Ω. 

 Remove the five Allen key screws and remove the Bushing Adaptor top cover. 

Note: Suitable tools are specified in Table B-3: Customer-supplied items. 

 Install a liquid-tight fitting (as listed in Table B-3: Customer-supplied items) into the 
Bushing Adaptor top cover. Use a sealing gasket to ensure a liquid tight seal. 

Note: The Bushing Adaptor thread for the liquid-tight fitting is ½ in. NPSM as 
illustrated in Figure 5-10. 
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Figure 5-10: Liquid-tight fitting thread 

 Thread the end of the metal liquid tight conduit as well as the coaxial cable into the 
fitting. Terminate the conduit into the fitting carefully to form a liquid-tight assembly. 

 Place the O-ring in its seat for the cover (see Figure 5-5). 

 Connect the coaxial cable as outlined in Appendix C.4. 

 
Figure 5-11: Bushing adaptor terminal block 

 Push the top cover down on its seat and re-assemble using the five Allen key screws. 

 To compress the sealing O-ring evenly, tighten the five screws progressively working 
across the circle rather than around the circle of screws as illustrated in Figure 5-12. 
Tighten the screws to the torque specified in the installation drawing (46-XXXX) 
provided with each Bushing Adaptor. 

 

Ensure that there is no tension or stress on the coaxial cable and that there 
is a loop of cable inside the Bushing Adaptor to allow for strain relief of the 
coaxial cable. 
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Figure 5-12: Tightening order 

Route all the Bushing Adaptor cables through conduit to the product cabinet. If the 
cabling is being routed as part of the pre-installation work, then ensure that the phase is 
properly marked on each coaxial cable. 

 High Frequency Current Transformer (HFCT) Connection 

Preparation of the coaxial cables is outlined in Appendix C.3 and C.6. 

 

WARNING: Ensure that the Bushing Adaptor has been assembled carefully 
with the liquid tight fitting and conduit to form a liquid tight connection. 
Water ingress inside the bushing may result in catastrophic failure. 

 

WARNING: The HFCT must be installed on a ground cable or bar going 
from the high voltage neutral bushing (typically identified as H0) directly to 
ground. There must not be any open switches between the path to ground 
from the neutral bushing while the transformer is energized. 

 

WARNING: If there is a switch on the path to ground from the high voltage 
neutral bushing as shown in Figure 5-13, the HFCT must NOT be installed 
between the switch and the neutral bushing, because if for any reason the 
switch is opened there will no longer be a direct path to ground causing a 
potentially hazardous condition. 

 

WARNING: Prior to any test that requires the removal of the transformer 
neutral ground, any installed HFCT must first be removed. Replace the 
HFCT after the transformer ground has been reconnected. 
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Figure 5-13: HFCT cannot be installed if a switch is on cable from the Neutral Bushing to ground 

To minimise noise, the HFCT should be installed as close to the High Voltage Neutral 
bushing as possible provided there is no switch on the path to ground as per the warning 
above. Figure 5-14 and Figure 5-15 show the correct installation of the HCFT. 

 
Figure 5-14: HFCT installed on cable from the Neutral Bushing (H0) directly to ground 

 
Figure 5-15: Star configuration (Y- Connection) 

Similarly, in Figure 5-16, the HFCT can be installed after the switch. However, it should be 
understood if for any reason the switch is opened, the path to ground will be interrupted 
and the HFCT will have absolutely no positive affect, resulting in PD diagnostic 
capabilities being disabled. 
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Figure 5-16: HFCT installed after the switch on cable from the Neutral Bushing to ground 

The HFCT (if to be fitted) is specific to the transformer connection point (as provided in 
the pre-installation information). Fit the HFCT clamp to the neutral ground connection as 
shown in Figure 5-14. An example of the HFCT is shown in Figure 5-17. Note: The HFCT 
arrow must point towards earth. 

 
Figure 5-17: HFCT - example 

As with the Bushing Adaptor cables, the HFCT cable should be routed through the 
conduit to the product cabinet. If the cable routing is carried out as part of a pre-
installation activity, mark the cable end to identify it as the appropriate Neutral 
connection. 

 Magnetically-Mounted Temperature Sensors 

 

If working at heights is required during the product installation, it is the 
responsibility of the installer as a minimum to: 

▪ ensure that planned work complies with national and site regulatory 
requirements. 

▪ ensure that any third-party equipment to be used is suitable and safe 
before commencing work. 

▪ ensure that third parties have received appropriate training for 
working at height. This includes, but is not limited to, ‘Working at 
height’ and ‘Using Mobile Elevated Working Platforms’. 

 

WARNING: The Thermal Compound and Silicone Safety Data Sheet 
guidelines must be followed. 
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The Magnetically-Mounted Temperature Sensor (MMTS) as shown in Figure 5-18 to 
Figure 5-20 should be attached at the top of the transformer to allow the top oil 
temperature to be monitored. 

 

Figure 5-18: MMTS rear 
view 

 

Figure 5-19: MMTS front 
view 

 

Figure 5-20: MMTS side view - #1 

To install the MMTS on a transformer: 

▪ Apply a liberal amount of thermal compound (Wakefield Engineering Thermal Joint 
Compound 120 series, GE P/N: CONS01026) on the metal probe located in the 
centre as shown in Figure 5-18. Note: A lack of thermal compound degrades sensor 
performance. 

▪ Apply RTV silicon sealant around the edge of the MMTS. This helps keep out 
moisture and aids in the adhesion. Note: No RTV silicon is supplied with the 
product. 

If installing more than one MMTS, they must be wired in series ensuring that the last 
MMTS on the CANbus line is MMTS #1. Keep a record of which MMTS is installed to which 
single phase transformer so that the product can be commissioned accordingly. See Step 
23 in Appendix Table D-1: Results. MMTS #1 has a cable gland, a blanking plug and an 
internally fitted termination resistance on the PCB between H and L. 

A 20-metre 4-wire CANbus cable (Belden 8729) is supplied with the product to connect 
the MMTS (see Appendix B). 

Note: Additional cabling may have been purchased. 

Route the cable from the MMTS(s) to the product cabinet, cutting as required. Figure 
5-21 to Figure 5-22 illustrate the terminal connections inside the MMTS. Figure 5-30 
shows the CANbus connection inside the cabinet. 

Notes: 

▪ The shield is connected to the ground of the CANbus terminal block (see Figure 
5-30). 

▪ It is advisable that the cables are run inside a plastic conduit to provide protection 
against mechanical damage. 

▪ The cable must be properly inserted into the cable gland. The dome nut of the cable 
gland must be tightened to a torque of 1.62 N m (14.4 lb in) using a torque wrench. 

 

At installation, the MMTS should be oriented with the cable gland pointing 
down as shown in Figure 5-19. This will minimise the risk of water ingress 
to the sensors. 

Metal 
Probe 
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Figure 5-21: MMTS #1 with jumper 

 
Figure 5-22: MMTS #2/3 without jumper 

Terminal Key 
1 (SHD) Shield 
2 (+)        12 V DC (red) 
3 (H)       CANH (green) 
4 (L)        CANL (white) 
5 (-)         Ground (black) 

5  4  3  2  1 

1 
2 
3 
4 
5 

5  4  3  2  1 
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 Communications Connections 

The chosen communication line must be routed to the product cabinet. The RS-485 
Modbus must be connected directly to the DIN rail. Alternatively, if fibre optic or 
armoured Ethernet cable is used, it must be connected to the optional communications 
module as shown in Figure 5-23. This module supports Ethernet Modbus, DNP 3.0 and 
IEC 61850 protocols. Fibre optic communication is recommended if the control room is 
located outside the substation. 

 
Figure 5-23: Fibre optic module 

 Cabinet Connections 

 Earth 

First connect the protective earth conductor to the earth protective conductor terminal, 
which is adjacent to the fuse holder on the DIN rail. 

 
Figure 5-24: Earth adjacent to the fuse holders 

 

ALL cables entering the cabinet should have at least 150 mm (6 in.) of 
excess length to allow for cable strain relief. 

 

WARNING: Do not open the cabinet during rain or snowstorms during the 
installation process. 

Earth 

Fuse 
Holders 

Relays 

Comms. 
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The product cabinet has a primary protective earth bonding lug as shown in Figure 5-25 
(bottom left-hand side corner when viewed from the front). This bonding lug and the 
mounting stand must be connected to earth in accordance with local practices and 
safety codes. 

 
Figure 5-25: Position of primary protective earth bonding lug 

 Ambient Sensor 

The ambient temperature and relative humidity sensor is fitted in a raised position for 
transit as shown in Figure 5-26. Loosen the gland nut and lower the sensor fully as 
shown in Figure 5-27. Retighten the gland nut. 

 

Figure 5-26: Ambient sensor - raised 
 

Figure 5-27: Ambient sensor - extended 

 Mains AC 

 

WARNING: Only use cables rated at 75 °C minimum for the installation. 

 

WARNING: An external circuit breaker must be installed on the AC source 
near to the product and within easy reach of the operator. It should be 
clearly labelled as the disconnecting device for the product. 

 

WARNING: Fuses and circuit breakers must be installed in accordance 
with the local and/or national wiring regulations. 

 

WARNING: The outer sheath of the mains supply cable should continue 
into the equipment as far as possible so that reinforced insulation is 
maintained between the operator and mains supply. 
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Ensure that the mains AC supply is de-energised. Connect the mains AC supply cable 
through the left-most cable gland of the cabinet to the product fuse holder (see Figure 
5-24). 

Note: Refer to the local/national wiring requirements to determine the gauge and 
length for the power supply wiring. 

 Bushing Adaptors & HFCT(s) 

An overview of the Bushing Adaptor connections is shown in Figure 5-28. The input 
terminals for the coaxial cable connections are identified as S1, S2, S3, P1, P2, P3, N1, N2, 
N3 (Core and Shield). See Section 4.5 Bushing Adaptor Cable Runs. 

 
Figure 5-28: Bushing adaptor connections 

 

WARNING: The mains supply should be connected so that the protective 
earth wire should be the last wire to take the strain and break free in the 
event of the cord being pulled out of the cabinet. Tighten the cable gland to 
secure the cable. 

 

Before connecting the Bushing Adaptor coaxial cables to the product 
cabinet, test that the ground connections have been made correctly. Verify 
that there is continuity from the shield of each of the Bushing Adaptor 
cables to the product cabinet ground terminal. 

 

An external circuit breaker must be installed on the AC source near the 
product and within easy reach of the operator. It should be clearly labelled 
as the disconnecting device for the product. 
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The interconnecting coaxial cables between the grounding switches and the main board 
are installed in the factory as shown in Figure 5-29. The order of the board inputs is from 
left to right as follows: 

▪ Three Secondary Bushing Adaptor inputs: phases S1, S2 and S3. 

▪ Three Primary Bushing Adaptor inputs: phases P1, P2 and P3. 

▪ Neutrals N1, N2 and N3. 

For each input the coaxial central wire is connected to the core (CO) on the left and the 
shield (SH) on the right as shown in Figure 5-29. 

 
Figure 5-29: PCB phase inputs - Secondary (left), Primary (middle) & Neutral CT (right) 

For connection of the Bushing Adaptors as well as the HFCT(s) to the grounding switch 
terminals, see Appendix C.5 and C.6. 

 

WARNING: The rated maximum working voltage that may be present on 
each phase is 5 V AC rms and the rated maximum current that may be 
present is 200 mA. The measurement category is CAT III for circuits that can 
be connected to any coaxial cable connection. 
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 Magnetically-Mounted Temperature Sensors 

The MMTS is connected to the CANbus connectors on the DIN rail. See Figure 5-4 for an 
overview to the key parts of the product and Figure 5-30 below for a more detailed look 
at the connection points. 

 
Figure 5-30: CANbus Connection on the DIN rail 

Due to the inability to reach the MMTS(s) once the transformer is energised, 
communication with the sensor must be tested before the transformer is switched on (if 
power to the product is available). Refer to the ‘Measurement’ section of the Intellix™ 
BMT 330 User Manual and check that the Field Sensors Error for Top Oil is not increasing 
by 1 every second and that the respective temperatures in the Field Sensors are within 
the expected range. 

CAN Low (LO) 

CAN Shield 

CAN Ground 

CAN 12 V RS-485 B 

CAN High (HI) 

RS-485 A 

RS-485 A Shield 
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 Communications 

 RS-485 Modbus (standard) 

The standard RS-485 connection is routed to the DIN rail from the main PCB as shown in 
Figure 5-30. 

 Copper Ethernet (optional) 

Copper Ethernet supports the Modbus protocol with DNP 3.0 or IEC 61850. With this 
equipment, only shielded cable should be used to meet the required EMC standards. If an 
optional communication channel has been specified, there will be an extra module on 
the Intellix™ BMT 330 motherboard as shown in Figure 5-31. This module supports 
MultiMaster communications. 

 
Figure 5-31: Copper Ethernet 

For more details on how to configure the optional communication module, see Appendix 
E. 

The copper-based channel requires a cat 5e Ethernet cable and a clamp-on ferrite 
(included in the Installation kit, see Appendix B). This cable must enter the cabinet 
through one of the available cable glands and must be routed to the communication 
module. The ferrite must be added to the Ethernet cable with 3 loops (4 passes) inside 
the cabinet close to where the cable exits the cabinet. 
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 Fibre Optic Ethernet 

Fibre optic Ethernet supports the Modbus protocol with DNP 3.0 or IEC 61850. If an 
optional communication channel has been specified, then there will be an extra module 
on the Intellix™ BMT 330 motherboard as shown in Figure 5-32. This module supports 
MultiMaster communications. 

- Recommended Multimode Fiber Optic cable be used 

- Connection to the Fiber Optic module in the BMT 330 is ST type 

- Fiber Optic module is a 100BaseFX (100 Mbps) 

 

 
Figure 5-32: Fibre optic module 

For more details on how to configure the optional communication module, see Appendix 
E. 

If the chosen physical layer is fibre optic, then the module can be connected to a 
converter of the customer’s choice. Use the following procedure for proper connection 
(even where a converter is not used): 

To connect to the Intellix™ BMT 330 serial fibre optic module as shown in Figure 5-33, 
the cable must enter the cabinet through one of the available cable glands and be routed 
to the communication module as follows: 

▪ The fibre optic cable coming from the host fibre optic Tx connector should go to the 
Rx connector of the Intellix™ BMT 330 serial fibre optic module. 

▪ Then connect the fibre optic wire coming from the Rx connector of the host fibre 
optic module to the Tx connector of the Intellix™ BMT 330 serial fibre optic module. 
See Figure 5-33 below. 

 

LED transmitters for fibre optics are classified as IEC 60825-1 Accessible 
Emission Limit (AEL) Class 1. Class 1 devices are eye-safe to the unaided 
eye. Do not view directly with optical instruments. Laser radiation. Do not 
view directly with optical instruments. 
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Figure 5-33: Fibre optic connections 

 GPS Antenna 

The Intellix™ BMT 330 has a built-in GPS chip, which is used to provide a date/time 
stamp to the event monitoring. The supplied GPS antenna has a magnetic mounting. 
Place the GPS antenna in a position where it has a clear view of the sky. Route the 
antenna cable into the product cabinet via one of the cable gland entries. The antenna 
cable should be connected to the dedicated point at the top right hand of the PCB as 
shown in Figure 5-34. 

 
Figure 5-34: GPS antenna connection point 

The following points must be considered in choosing the location of the GPS antenna: 

▪ The antenna must have a clear line-of-sight of a significant portion of the sky so that 
GPS satellite signals can be received. 

▪ The antenna is magnetically mounted so a suitable ferromagnetic surface must be 
found. This ferromagnetic surface must be grounded. 

Connect host Rx Fibre 

Connect host Tx Fibre 
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▪ If the product cabinet is installed at a location with a clear view of the sky, the 
antenna can be installed on the exterior of the cabinet. A ferromagnetic plate is 
welded towards the top-right interior corner of the cabinet to allow the GPS 
antenna to be magnetically mounted externally at this position as shown in Figure 
5-35. 

▪ Although the antenna does not increase the likelihood of a lightning strike, the 
surface itself must not be part of a structure that might potentially become a 
lightning conductor. 

▪ The GPS antenna is supplied with a 5 m (16.4 ft) cable. 



MA-017 – BMT 330 Installation Manual – Rev 3.3 4-Mar-22 Page 34 of 69 

 

 
Figure 5-35: Cabinet - external top right - GPS antenna 

If no suitable place is found (and no GPS antenna has been installed) or the GPS signal is 
lost during operation, the product will use an internal clock to time stamp events and 
data. This clock is continuously synchronised with the GPS time when available. If no GPS 
is available at power up, the product will use the time stamp of the most recent event or 
data to use as the current time. As soon as the GPS is available, the product will 
synchronise back to the GPS time. If communication is established with the product and 
no GPS synchronisation has occurred, the user must synchronise the Intellix™ BMT 330 
time to the PC’s time. The time will be lost if the product is switched off. Refer to the 
‘Device Information’ section in the Intellix™ BMT 330 User Manual. 

 Alarm relays 

Three alarm relays are provided on a small PCB as shown schematically in Figure 5-36 
and are wired to connector blocks on the DIN rail as shown in Figure 5-37. 

 
Figure 5-36: Relay board (schematic) 

 
Figure 5-37: Relay connections (right) 
and Mains (left) 

These relays can be used to drive a hardware alarm e.g. control room light, klaxon etc. 
The precise alarm conditions to activate each of the relays is configured using the 
Intellix™ BMT 330 Setup Software. 

 

– internal top-right - 
ferromagnetic side plate 
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The maximum drive capacity of each relay is: 

2 A @ 240 V AC, resistive load, or 

2 A @ 30 V DC. 

If connecting external alarms to these relays, route the cables though one of the 
available cable glands. 

The pin-out from top to bottom is listed in Table 5-1. 

Table 5-1: Relay connections 

Relay # Symbol Purpose 

1 SERVICE 

NO Normally Open 

NC Normally Closed 

C Common 

Green/Yellow terminal Ground 

2 WARNING 

NO Normally Open 

NC Normally Closed 

C Common 

Green/Yellow terminal Ground 

3 ALARM 

NO Normally Open 

NC Normally Closed 

C Common 

Green/Yellow terminal Ground 

 Configuration and commissioning 

Once all connections are made, the product must be configured using the companion 
Intellix™ BMT 330 Setup Software. Refer to the Intellix™ BMT 330 User Manual for the 
software installation, and for commissioning information refer to the Intellix™ BMT 330 
Commissioning Instructions. 

 Decommissioning 

Before decommissioning ensure that the original bushing test tap caps are available and 
in good condition. 

Before decommissioning, download the latest data if required (data can also be retrieved 
later since it is internally stored on an SD card). 

 

WARNING: Only use cables rated at 75 °C minimum for the installation. 

 

WARNING: Follow the steps in the order below ensuring that the 
transformer and all AC supplies (including any relay connection) to the 
product cabinet are de-energised before commencing the 
decommissioning. Follow LOTO procedures. 

 

WARNING: Do not open the product cabinet during rain or snowstorms. 
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Perform the following steps to decommission the product: 

1. De-energise and switch off the transformer; ground the transformer main leads 
and apply LOTO. 

2. Remove power from the AC supply to the product and apply LOTO procedures. 

3. Remove power from the relay supplies that are controlled by the product and 
apply LOTO procedures. 

4. Open the product cabinet. 

5. Remove the AC supply cable from the fuse holders (see Figure 5-24). 

6. Remove the relay control cables from the relay board (see Figure 5-37). 

7. Replace the product Bushing Adaptors with the original tap covers. 

8. Remove cabling and external sensors (MMTS, GPS antenna and HFCT). 

9. Remove the cabinet and stand. 

10. Re-energise the transformer. 

 

The SD card should only be retrieved by an approved engineer — under no 
circumstances should it be inserted into a PC as that would risk accidental 
reformatting and subsequently data loss. 

 

WARNING Failure to replace the original test tap caps may cause 
catastrophic failure of the bushing. 
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 Mounting Stand & Sun Hood 

Figure A-1 to Figure A-4 below show the dimensioned drawings of the Intellix™ BMT 330 
stand and sun hood. These are for illustration purposes only. If pre-installation work 
depends upon the stand dimensions, request the current issue of these drawings before 
commencing any work. 

 
Figure A-1: Upper (or transport) stand 
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Figure A-2: Lower stand 

Note: Each foot on the base stand has three available mounting holes (of which only 
one hole is required). 
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Figure A-3: Sun hood 
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Figure A-4: Intellix™ BMT 330 with stand and sun hood attached 
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 Parts and Tools List 

The parts, supplies and tools for a product installation are listed in tables Table B-1 to 
Table B-3 and are needed on site at the time of the installation. 

Note: Confirm with GE Technical Support as lubricants and quantities are subject to 
change without prior notice. 

B.1 GE-supplied items (shipped with the product) 

Table B-1: GE-supplied items 

Qty Description 

Standard Items 

1 Intellix™ BMT 330 (Bushing & PD Monitor) 

3 Primary Bushing Adaptors (for basic installation) 

3 Secondary Bushing Adaptors (optional for full installation) 

Note: Each Bushing Adaptor is supplied with a full set of O-rings 
(and one spare set) 

Up to 4 High Frequency CT (optional) 

Up to 4 Magnetically-Mounted Temperature Sensors (MMTS) 

1 Ambient temperature and relative humidity sensor 

1 Base stand (optional) 

1 GPS antenna (supplied with 5 m cable) 

Installation Kit 

1 Optional: RG58C/U 50 Ω coaxial cable (Belden P/N: 8262) to 
connect the Bushing Adaptor and Neutral CT to the product. 
Length to be determined from the pre-installation information 
(GE P/N = CABL02048). 

 

1 4-wire CANbus cable (Belden 8729) (20 m long) to connect the 
MMTS to the product. Additional cable must be ordered or 
sourced when single phase transformers are being monitored 
(GE P/N = CABL02053). 

 Hardware for coaxial cables connection: 

15 ▪ Red pin terminals 18-22 AWG (Molex 19213-0009) 

 

1 ▪ Heat shrink 3/16 in. tubing 60 mm (2.4 in) 
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Qty Description 

1 ▪ Heat shrink ¼ in. tubing 60 mm (2.4 in) 

 
 

6 of 
each 

(N x8) 

 

Cable markers P, S, N, 1, 2, 3 and 4 

       

1 P/N: CONS01149 - MG Carbon Electrically Conductive Grease 
846 

1 Thermal jointing compound (Wakefield Engineering, 120 series) 
(GE P/N: CONS01026) 

1 Ethernet cable Ferrite (Würth 7427 154) when optional copper 
Ethernet module is ordered (GE P/N: ELEC04004) 

> One spare O-ring for each bushing adaptor is supplied 

B.2 GE Field Service Engineer (FSE)-supplied items 

If GE performs the installation, the GE FSE will bring the following items: 

Table B-2: GE FSE-supplied items 

Qty Description 

1 Handheld multimeter 4½ digit with: 

▪ Testing continuity capability 

▪ AC voltage measurement (0.5%) 

▪ Resistance measurement (0.5%) 

(Suggested model: Fluke 87 or 287 or equivalent). 

> Required material as described in ‘Appendix D - Bushing Adaptor 
Circuit Integrity Test Record’ of the Intellix BMT 330 Installation 
Manual. 

1 27 mm socket to fit ½ in. square drive torque wrench 

1 ½ in. square drive torque wrench with a capable range of 10 - 
100 Nm (7 – 73 lb ft) 

1 1.25 N m torque screwdriver 

1 3 mm ball hex blade for torque screwdriver 

1 Ratchet crimp tool. 

B.3 Customer-supplied Items 

The following items are procured by the customer: 

Table B-3: Customer-supplied items 

Qty Description 

1 Armoured mains cable to power the product. 

1 Grounding cable to connect primary protective earth terminal 
lug of the product cabinet to the ground. 
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Qty Description 

> Liquid-tight flexible metal conduit (½ in. and/or ¾ in.) to provide 
protection for the Bushing Adaptors’ cables and Neutral CT 
cable (working temperature range: −55 °C to 105 °C 
recommended). 

Recommended models from Thomas & Betts: 

▪ Metal conduit ½ in. liquid-tight, Model ATLA050-30 (30 m) 

▪ Metal conduit ½ in. liquid-tight, Model ATLA050-150 (150 m) 

▪ Metal conduit ½ in. liquid-tight, Model ATLA050-300 (300 m) 

> Liquid-tight metal fittings and gaskets for the Bushing Adaptor. 

Recommended model from Thomas & Betts: 

▪ Liquid-tight fittings, Model 5332-HT 

▪ Sealing gasket ½ in., Model 5262 

> Plastic conduit in sufficient length to provide protection for the 
temperature sensor cables (optional). 

> Cable trays and cable ties to run the cables. 

1 RTV (Room Temperature Vulcanisation: silicon-based mastic), 
3M Super Silicone Sealant No. 8663 or equivalent for the MMTS. 

1 Heat gun (for heat shrink) 

> General tools (drill, drill bits, screwdrivers, cutter and spanners) 
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 Connecting Coaxial Cables 

Follow these steps to connect the coaxial cables: 

C.1 Routing the Coaxial Cables 

1. Route the coaxial cables through the metal conduits from each Bushing Adaptor to 
the product cabinet as required. 

2. On the cabinet side, the coaxial cables must be routed though the connector fittings 
at the bottom of the cabinet. Each cable can be up to 100 m and must be identified 
with cable markers. 

3. All the coaxial cables must be connected to the Bushing Adaptor on one end and to 
the grounding switch inside the cabinet on the other end. 

C.2 Required Materials & Tools 

Identify the materials listed in Table C-1 for connecting the coaxial cables to the Bushing 
Adaptors and to the shorting switch. 

Note:  All these materials are shipped with the product. 

Table C-1: Required materials 

Coaxial cable RG-58C/U 
150m (500ft) 

 

Red pin terminals 

 

Qty 15 

Heat shrink 3/16 in. tubing  
60 mm (2.4 in.) 

Heat shrink ¼ in. tubing  
60 mm (2.4 in.)  

Cable markers 

       

Qty 6 6 8 6 6 6 6 

The following tool as shown in Table C-2 is supplied by the customer and is 
recommended for preparing the coaxial cables. 

Table C-2: Required tools 

Heat gun 
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C.3 Coaxial Cables Preparation 

Note: Each coaxial cable must be prepared on both ends (Bushing Adaptor and 
cabinet) as follows. 

Table C-3: Coaxial cables preparation 

Steps Visual 

1. Cut the 3/16 in. heat shrink tubing. into 
pieces approximately 30 mm (1 ¼ in.) 
long. 

2. Cut the ¼ in. heat shrink tubing into 
pieces approximately 30 mm (1 ¼ in.) 
long.  

3. Remove approximately 40 mm (1 ½ 
in.) of the outer jacket from the coaxial 
cable taking care not to cut the 
metallic braid. 

 

4. Un-strand the metallic braid shield 
and twist it together. 

 

5. First insert the ¼ in. tubing through 
the central conductor and shield. 

6. Then insert the 3/16 in. tubing through 
the metallic braid. 

 

7. Use a heat gun to shrink the 3/16 in. 
tubing. 

 

8. Then, insert the ¼ in. tubing to overlap 
about 15 mm (0.6 in.) over the metallic 
braid. 

9. Use a heat gun to shrink the ¼ in. 
tubing. 

10. Strip away about 7 mm (¼ in.) of 
insulation from the central conductor. 
Twist the strands together. 

 

 

C.4 Connecting to the Bushing Adaptor 

Note: At the Bushing Adaptor end, the coaxial cables must be terminated with two 
pin terminals. 
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Table C-4: Connecting to the Bushing Adaptor 

Steps Visual 

1. Select two red pin terminals and the 
corresponding hand crimp tool. 

 

2. Insert the central conductor of the 
coaxial cable into one pin terminal and 
crimp that terminal. 

3. Insert the braid shield into the second 
pin terminal and crimp that terminal. 

4. The terminals must be double crimped 
(once on the bare wire and once on 
the insulation). Verify visually and by a 
pull test on the terminals. 

 

5. Insert the coaxial cable through the 
connector fitting of the Bushing 
Adaptor cover. 

6. Connect the wires to connector J3 of 
the Bushing Adaptor board. 

7. J3 is a spring-cage type connector. 
Open the terminal point with a small 
flat screw driver. 

8. The central white wire must be 
inserted into the inner terminal. 

9. The braid shield must be inserted into 
the outer terminal. 

 

10. A fully connected Bushing Adaptor is 
shown. 

 

C.5 Connecting to the Grounding Switch 

Note: At the cabinet end, repeat the steps 1-4 in Section C.4 above and use the same 
pins to terminate the cable. 
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Table C-5: Connecting to the grounding switch 

Steps Visual 

1. The central white wire must be 
connected to the core connector. 

2. The braid shield must be connected to 
the shield connector. 

 

3. Repeat these steps for all input phases 
for the Bushing Adaptors and the 
Neutral CT(s). 

 

C.6 Connecting to the Neutral CT 

Note: At the Neutral CT end, the coaxial cable does not require terminals. 

Table C-6: Connecting to the Neutral CT 

Steps Visual 

1. Remove approximately 25 mm (1 in.) 
of the outer jacket from the coaxial 
cable (taking care not to cut the 
metallic braid). 

 

2. Un-strand the metallic braid shield 
and twist it together. 

 

3. Select one piece of heat shrink tubing 
3/16 in., about 15 mm (5/8 in.) long. 

 



MA-017 – BMT 330 Installation Manual – Rev 3.3 4-Mar-22 Page 48 of 69 

4. Insert the tubing through the metallic 
braid and heat shrink the tubing. 

5. Strip away about 7 mm (¼ in.) of 
insulation from the central conductor. 
Twist the strands together.  

6. Remove the connector fitting from the 
CT. 

7. Insert the dome nut, fitting body and 
seal ring through the coaxial cable as 
shown. 

 

8. Connect the cable to the terminals of 
the CT. 

9. The central white wire must be 
connected to the core side. 

10. The braid shield must be connected to 
the shield side. 

11. Tighten the set screws using a hex key 
wrench (1.5 mm). 

 

12. Screw the fitting body into the HFCT 
with the seal ring. Hold the wire to 
prevent it from twisting. 
Recommended torque is 3.75 N m (33 
lb in). 

13. Screw the dome nut tightly into place. 
Recommended torque is 2.50 N m (22 
lb in). 

14. The fitting and the nut must be 
tightened properly to prevent water 
ingress. 
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 Bushing Adaptor Circuit Integrity Test Record 

The Bushing Adaptor Circuit Integrity Test is to be performed upon installation, after 
periodic transformer maintenance or any bushing repair activities. 

D.1 Required Material 

▪ Antenna Analyser, RigExpert (model: AA-170) 

▪ UHF to BNC adaptor 

▪ Coax cable with BNC connector at one end and clips at the other end as shown in 
Figure D-1 

 
Figure D-1: Coax BNC to clips cable 

▪ Two small flat screwdrivers or a 2-pin connector and a release key as shown in 
Figure D-2 

 
Figure D-2: 2-pin connector and release key 

▪ USB cable with type B connector 

▪ PC with AntScope software installed 

▪ 50 W wire-through resistor 

▪ Ohmmeter 

D.2 Test Procedure 

The RigExpert AA-170 handheld antenna analyser is used to verify the electrical 
connection of the internal Bushing Adaptor. Before commencing the test: 

 

Ensure that the transformer is switched off and properly grounded. The 
Intellix™ BMT 330 shall not be energised. 
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Figure D-3: Disconnection of coaxial cables 

Follow these steps to calibrate the AA-170. 

Note: The calibration considers the waveguide between the measuring circuit and the 
load i.e. adaptor + cable + cable position. 

Note: It is important to keep the cable straight between the AA-170 and the Bushing 
Adaptor during all the measurements. 

1. Create a new folder on the computer. Next create a subfolder for each Bushing 
Adaptor using its corresponding serial number as the name. 

Note:  These folders are used to save the data measured by the AA-170. 

2. Connect the AA-170 to the PC via the USB cable. 

3. Power on the AA-170. 

4. Open the AntScope software. 

 

The grounding switches for the coaxial cables in the product cabinet are to 
be set to ‘not grounded’ (operational position). 

 

Disconnect ALL the coaxial cables as shown in Figure D-3. 
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5. Set the COM port assigned to the AA-170 as shown in Figure D-4. 

Note: To verify that this COM port is the one assigned to AA-170, check the 
vendor id (VID=0403) and product id (PID=6001). 

 
Figure D-4: AA-170 - USB serial port 

6. Select the AA-170 as the antenna analyser model in the AntScope software (select 
Configure and then AA-170). 

7. Place the coaxial cable so that during the calibration and the subsequent 
measurements minimal movement of the cable will occur. Leave the clips 
unconnected, i.e. open circuit, as shown in Figure D-8). 

8. Select Action > Scan to configure the resolution and scanning range. Type 100 
points for the resolution, click the Set full range button (or press F9) and click OK 
as shown in Figure D-5. A measurement will be triggered. 

 
Figure D-5: 100 points and ‘Set full range’ 

9. The progress of the scan is displayed on the status bar (bottom left of the AntScope 
window). Wait until the scan is finished. 
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10. Use this measurement for calibration. Select Configure > Save calibration > as 
“open” as shown in Figure D-6. 

 
Figure D-6: Save calibration as “open” 

11. Select File > Save As and type the filename calibOpen as shown in Figure D-7 to 
save the data in the folder created in Step 1 for this Bushing Adaptor. 

 
Figure D-7: Save "open" calibration data 

12. Connect the clips to each other as shown in Figure D-9 and run another 
measurement (press F8 or click the button). Select Save calibration > as “short” 
and type the filename calibShort. 

13. Connect the 50 Ω resistor across the clips as shown in Figure D-10 and run another 
measurement. Select Save calibration > as “load” and type the filename calibLoad. 



MA-017 – BMT 330 Installation Manual – Rev 3.3 4-Mar-22 Page 53 of 69 

 
Figure D-8: Open calibration 

 
Figure D-9: Short calibration 

 
Figure D-10: Load 
calibration 

14. Select the Configure menu item and ensure that Use calibration data is checked 
as shown in Figure D-11. 

Note: If the calibration is used, a message stating “Using OSL calibration” is 
shown on the top left of the graph. 

 
Figure D-11: Use calibration data 

15. Select View > Phase to change the display. 

16. Connect the clips to the Bushing Adaptor using the short cables in the adaptor’s 
connector as shown in Figure D-12. 

 
Figure D-12: Bushing adaptor measurement 
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17. Run another measurement (press F8 or click the  button). Select File > Save as 
and type the filename adaptorOnly. 

18. Connect the Bushing Adaptor as outlined in Section 5.2 Bushing Adaptor 
Connections. 

19. Redo the measurement (press F8 or click the  button). Select File > Save as and 
type the filename adaptorInstalled. 

20. Click the  button to show both sets of data on the graph (the previous scan as 
well as the latest scan) as shown in Figure D-13. 

 
Figure D-13: Data analysis 

21. The Bushing Adaptor internal pin is correctly installed if the phase change frequency 
changes as shown in Figure D-13. Otherwise there is no electrical contact and the 
installation must be terminated and the original test tap covers replaced. 

22. Record the Manufacturer nameplate information in Table D-1: Results (below) for 
each bushing: Serial Number, PF%, C1, C2 and Temperature. Photograph the 
bushing plate where these values are listed. The plate pictures must be stored with 
the installation report, commissioning report and the antenna analyser data. 

23. Record the Bushing Adaptor ID in the Results table. If installing more than one 
MMTS (for multiple single phase transformers) also record which temperature 
sensor is associated with this bushing. 

24. Repeat steps 16 to 23 for each Bushing Adaptor installation on the transformer. 
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25. For each Bushing Adaptor, test the continuity between the coaxial cable shield and 
ground at the cabinet as shown in Figure D-14. It should be less than 5 Ω. Record 
this measurement in the Results table. 

 
Figure D-14: Resistance between cable shield and ground 

26. For each Bushing Adaptor, measure the resistance between the coaxial cable core 
and the shield as shown in Figure D-15. Record this measurement as [R1] in the 
Results table. It should be less than 3000 Ω and within 5% of the Bushing Adaptor 
nominal resistance in Calibration > Bushing Adaptor > Input Impedance. Refer 
to the Intellix™ BMT 330 Service Manual. 

 
Figure D-15: R1 resistance measurement 
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27. For each Bushing Adaptor input, measure the resistance across the pins of the terminals 
as show in Figure D-16. Record this measurement as [R2] in the Results table. It should be 
less than 2000 Ω and within 5 % of the input channel impedance in Calibration > PCB > 
Phase Voltage > Input Impedance. Refer to the Intellix™ BMT 330 Service Manual. 

 
Figure D-16: R2 resistance measurement 

28. Reconnect all the coaxial cables. 

29. Retest the resistance across the two screws of the connector as shown in Figure 
D-15 for each Bushing Adaptor. Record this measurement as [R3] in the Results 
table. 

30. Ensure that the measurement of [R3] is within 5% of the total input resistance 
[Rinput] calculated from [R1] and [R2] for each input. 

Note: The total input resistance [Rinput] is calculated as [Rinput]=1/(1/[R1] + 1/[R2]) 

31. Store a completed copy of the Results table with the transformer maintenance 
documents. 

32. Once the transformer is energised and the grounding switches are in the 
operational position (not grounded), measure the voltage drop across the core and 
the shield at the block terminals of the coaxial cables connected to the Bushing 
Adaptors and record these voltages in the Results table. These voltages must be 
within 0.9 to 1.4 Vrms. 

Note: This does not apply to the neutral inputs. 
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Table D-1: Results 
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STEP 23: Bushing Adaptor ID         

STEP 23: MMTS #         

STEP 21: Bushing Adaptor Internal 
Pin Correctly Installed 

        

STEP 22: Manufacturer Nameplate 
Power Factor % [PF%] 

        

STEP 22: Manufacturer Nameplate 
Capacitance [C1] 

        

STEP 22: Manufacturer Nameplate 
Capacitance [C2] 

        

STEP 22: Temperature at which 
nominal values were 
measured [T] 

        

STEP 25:  Shield to ground 
resistance (<5 Ohm) 

        

STEP 26:  Cable core to shield 
resistance [R1] 

        

STEP 27:  Board PCBA input 
resistance [R2] 

        

STEP 28: Measured resistance after 
reconnection [R3] 

        

STEP 30: [R3] within 5% of the 
[Rinput] (Yes or No) 

        

STEP 32 Measured voltage across 
co-axial input (Vrms) 
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 Communications Module Setup 

This appendix details the steps to update the communications settings for the optional 
Kalkitech module (if required at the time of installation). Figure E-1 illustrates the 
connectivity provided by the Kalkitech module. 

 
Figure E-1: Communication options between the BMT 330 and a customer network 

E.1 Network Settings 

For a computer to access the optional communications module, the computer must be 
set up to communicate on the same network. This is achieved by manually setting the 
computer network adaptor configuration as follows: 

IP Address: 192.168.0.xxx1 1 where xxx can take any value in the 
range 2-254, except for 121, which is the 
pre-assigned default IP address for the 
communications module. 

Subnet Mask: 255.255.255.0 

Default Gateway: 192.168.0.1 

The communications module has the following default TCP Port settings (limited by the 
communications options purchased): 

Table E-1: Default TCP Port settings for communications module 

Module Ethernet 
Connection 

Purpose Default TCP Port 

Modbus TCP Customer SCADA 502 

DNP3 Customer SCADA 20000 

IEC61850 Customer SCADA 102 

Modbus ASCII Over TCP/IP - 
transparent channel 

BMT Monitor Application Software 20 

Hardware or software firewalls should be disabled or set to enable communications on 
the assigned IP addresses and ports. 

A useful indication that the communications module has been detected is when the 
network icon on the taskbar reports an issue as shown in Figure E-2. 

 
Figure E-2: Network status 
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E.2 EasyConnect software installation 

Should it be necessary to alter the communications module IP settings from the factory 
default, EasyConnect software will need to be installed as described in the steps below. 
EasyConnect can be found on the CD shipped with the Intellix™ BMT 330. 

1. Copy the EasyConnect.4.10.0 zip file to a local PC as shown in Figure E-3. 

 
Figure E-3: EasyConnect 4.10.0.zip file 

2. Right click the EasyConnect 4.10.0.zip file and extract the software application to a 
folder on the local PC as shown in Figure E-4. 

 
Figure E-4: EasyConnect 4.10.0 folder 
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3. Open the EasyConnect 4.10.0 folder and double-click the Setup.exe file to install the 
software application as shown in Figure E-5. 

 
Figure E-5: EasyConnect Setup.exe file 

4. The ‘EasyConnect - InstallShield Wizard’ opens on the ‘License Agreement’ window as 
shown in Figure E-6. Select I accept the terms… and click Next to continue. 

 
Figure E-6: License Agreement 
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5. The ‘Choose Destination Location’ window displays as shown in Figure E-7. Click Next 
to accept the default installation folder. 

 
Figure E-7: Choose Destination Location 

6. The ‘Ready to Install the Program’ window displays as shown in Figure E-8. Click 
Install to start the installation. 

 
Figure E-8: Ready to Install the Program 
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7. The ‘Setup Status’ window shows the progress of the installation as shown in Figure 
E-9. 

 
Figure E-9: Setup Status 

8. The ‘InstallShield Wizard Complete’ window displays as shown in Figure E-10. Click 
Finish to exit the Wizard. 

 
Figure E-10: InstallShield Wizard Complete 

E.3 Communications module configuration 

The EasyConnect software can be used to interrogate the communications module 
settings. This allows the IP address (and other settings) to be changed and uploaded if 
required. 
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1. Start the EasyConnect software application (navigate to the ‘Kalkitech\EasyConnect’ 
folder and double-click the EasyConnect.exe file or use the EasyConnnect shortcut 
as shown in Figure E-11. 

 

 

Figure E-11: EasyConnect Installation folder & shortcut 

2. The EasyConnect application opens as shown in Figure E-12. Click the Upload button 

 to change the IP address. 

 
Figure E-12: EasyConnect main screen 
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3. In the Upload dialog box, type the IP address (the default is 192.168.0.121), uncheck 
the LAN settings box and click the Upload button as shown in Figure E-13. 

 
Figure E-13: Upload Kalkitech module settings 

4. In the left-hand tree view, select Protocol Configuration. When the new settings are 
received from the communications module, the configuration tree updates as shown 
in Figure E-14. 

Note: The number of configured channels on the communications module may show 
less than four (depending on the configuration purchased). 

 
Figure E-14: Protocol Configuration 
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5. To change the IP address from the default value, select Settings > IP Configuration 
as shown in Figure E-15. 

 
Figure E-15: IP Configuration 

6. The Lan Settings dialog box displays the Device name and current IP Address as 
shown in Figure E-16. Type the new IP address below (for example, 192.168.0.122), 
but leave the Subnet and Gateway on the default values and click OK. 

 
Figure E-16: LAN settings 
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7. The Lan Settings confirmation message prompts for a device restart. Click Yes to 
continue. 

 
Figure E-17: Restart confirmation 

8. The progress bar and subsequent Lan Settings confirmation message as shown in 
Figure E-18 indicates a successful change of IP address. Click OK. 

 
Figure E-18: IP address confirmation 

The communications module will restart and communications will be available using the 
new IP address. 

Note: If the communications module has been reconfigured to a different network, 
then the host computer must also be reconfigured to communicate on the new 
network and IP address/port. 
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 Front Panel Lights 

Table F-1: Front panel lights 

Light 
Colour 

Light 
Symbol 

Meaning 

Green 

 

AC power applied 

Blue 

 

Service Required. Triggered by one of: 

• Low Bushing current warning 

• Power system frequency warning 

• No signal warning 

• Bushing Adaptor Resistance failure warning 

Yellow 

 

A measured parameter has exceeded a user-programmed  
‘Hi’ alarm threshold. 

Red 

 

A measured parameter has exceeded a user-programmed  
‘Hi-Hi’ alarm threshold. 
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 Troubleshooting 

The troubleshooting actions outlined in Table G-1 can be performed onsite by a qualified 
General Electric technician or by authorised personnel. 

Table G-1: Problems and Actions 

Icon(s) Problem Action(s) 

 

The green Power light 
indicator does not turn on. 

• Check the AC power supply. 

• Check the protective circuit 
breaker is set. 

• Check the 3 A fuses in the Live 
and Neutral (see Figure 5-24). 

 

The red Alarm or amber 
Caution light indicator is 
flashing. 

• Reset the alarm. 

• Check the Alarm or Caution level 
setting. 

 

The blue Service light 
indicator is flashing. 

Maintenance action is required. 
Contact GE Technical Support. 

  

 

WARNING: The product may have more than one source of power supply, 
e.g. the alarm relays may be from an independent AC supply. Disconnect all 
supplies at their source before servicing. Apply LOTO procedures. 

 

WARNING: The product requires no periodic maintenance. If modifications 
must be made, switch off the external circuit breaker and ensure that the 
green LED power indicator is off. Once inside the product, disconnect the 
nine (9) grounding switches by placing the grounding bar at the screws and 
tightening them. 
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Contact & Copyright Details 

 

 

GE Grid Solutions (UK) Ltd 

Lissue Industrial Estate East 

Unit 1, 7 Lissue Walk, Lisburn, Co. Antrim 

Northern Ireland, United Kingdom BT28 2LU 

www.gegridsolutions.com/md.htm 

For further assistance or queries please contact: 

Customer Service Centre (24 hours a day, 365 days a year) 

T +44 1785-250-070 (United Kingdom) 

T 1-800-361-3652 (United States and Canada) 

T +1 514-420-7460 (worldwide) 

GA.support@ge.com 

GE, the GE monogram and Intellix are trademarks of the General Electric Company. 

Other company or product names mentioned in this document may be trademarks 

or registered trademarks of their respective companies. 

GE reserves the right to make changes to specifications of products described at any 

time without notice and without obligation to notify any person of such changes. 

This manual is accurate at the time of writing. For the latest release, please visit: 

http://www.gegridsolutions.com/md/catalog/BMT330.htm. 
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